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MINIMUM SYSTEM REQUIREMENTS
DARK SEED II: 100% compatible PC with a 486 DX/33 processor.

REQUIRED: MS-DOS 5.0 or higher, Windows 3.1, 8 MB RAM, 20 M8 of hard drive space, double-speed C0-ROM
drive and keyboard. (Note: If your system has 8 Mb of RAM, your Windows swap file size must be set to at least
10,000 kb.)

GRAPHICS: VESA compatible 256-color SVGA card.
MUSIC: Windows compatible sound card.




HOW TO INSTALL DARK SEED II
1) Insert the Dark Seed Il CD in your CO-ROM drive.

2) From Windows, Open the File menu and select Run. ..
Note: If you are using Windows 95, you need to click the Start button, then select the Run option.

3) In the Command Line section type D:Setup.exe and press [Enter].
Note: If your CD-ROM drive is not the D: drive, substitute the correct drive letter.

4) Within the Dark Seed |1 Setup screen, you can select the drive and directory you would ke to install to.If you
have the extra hard drive space, you can select a higher installation level which may speed up cinematic
sequences within the game. When you are finished with your choices, click the InStall button, then elick Yes
when you are asked to verify your installation choices.

b) When the installation is complete, the message “Setup Completed” will appear, click OK to proceed.

6) Next, Video for Windows will he_inslalled. If Video for Windows is already on your system, it will be replaced
with the latest version. Click Continue to proceed or Exit to cancel the Video for Windows installation. When
the installation is complete, click on the Restart Now option so that the new settings can take effect.

1) To play Dark Seed I, double-click the Dark Seed Il icon on your desktop.



THE STORY

Has it only been a year? It really seems like more than a century since | took a leave of absence from my adver-
tising agency. All | wanted was some peace and quiet, a place to sit and contemplate. . . and write. My life as a
successful ad man was going great, but | wanted more. | got more. When | rented my house-my dream house-in
Woodland Hills, | had no idea what nightmares would hatch like spider eggs in my mind. There was the living
room mirror. and the missing piece that came in the mail. And that was just the Start.

Oh, | would rather wipe the whole thing from my memary, but | fear | will never be allowed to forget. No one who
has seen the Dark World could ever drive those images from his head. No one. | broke down completely after it
was over, and took up unwilling residence in a variety of “rest homes” and mental wards. In those sterile halls
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and strapped-down beds, | remembered all too much. There was the Keeper of the Scrolls, who first told me about
the Ancients and their evil plots. (Why me? | asked myself again and again.) And the Ancients, themselves. Grue-
some. Horrific. Sickening. ..

| thought | had destroyed them when | blew up their spaceship, but the memaries. .. the horror.... would not let me
00. | thought | had won, but this past year |'ve often wondered if death would not have been easier. The dreams. ..

Finally, in a kind of paralyzed daze, | moved back home. Mom was there to take me in, a broken, confused man
whose dreams had turned dark and ugly. She didn’t really understand my lethargy, my distance. She thought me
dreamy; she had no idea what | dreamed. They said | was in good health, but what did they know about the indeli-
ble stain of the Dark World?

Being home helped, a little, and I'd even begun to think about the normal matters of life again. The simple things.
You know, like dating and having friends. That's where Rita came in. Rita Scanlon, my high school sweetheart.
We hadn't seen each other in a long time, but now that | was back, we were getting reacquainted. Although Rita
had changed and was more distant, | didn’t worry about it - after all, | had also changed, and in Stranger ways
than most. We went to our high school reunion together, or so they tell me. | don’t recall a thing about it. The night
vanished, just one big black hole in my memory. | think | got drunk.

I'm certain that | didn’t murder Rita, though. How could | have?

It's the Dark World. | know it is. They've found me again, and now they've murdered Rita. Sheriff Butler thinks |
did it. He'd never believe the truth. Nobody will believe me.

And my headaches are getting worse. Dr. Sims just keeps giving me medicine and more medicine. He doesn’t
understand either. 'm tired of being medicated all the time. I'm tired of the headaches. But most of all, I'm
scared. The Ancients are back. ..



GAME CONTROLS

DARK SEED Il is most easily played with a two-button Microsoft compatible mouse. If you have a three-button
mouse, only the left and right buttons will be active. The corresponding keyboard controls are the SPACE BAR
(right mouse button) and [ENTER] key (Ieft mouse button). The cursor arrow keys control directional movement.

On the screen, you will see an arrow-shaped pointer that you control. When your pointer is over a connecting
doorway which leads to another room or location, this Single arrow pointer changes to four inward-pointing
AITOWS.

To make Mike Dawson move, position the arrow pointer wherever you want him to go and click the left mouse
button. Mike will walk to this new position. If there is an unavoidable obstruction i his path, he will stop at the
closest possible point. If you press the left mouse button when the multiple arrows are displayed, Mike will walk
to the doorway and then to the adjoining location.

Clicking the right mouse button cycles the pointer shape through a “7” (look) shape, a “hand” (use/take/talk)
shape and an “arTOW” (go) pointer shape.

When the “?” and “hand” pointers are placed over items which have more information available, or which
Mike can pick upor use, te pointe changes shape. The “1" shape changes toa “1” and the “open hand”
shape changes to a “pointing finger”.

To examine or manipulate an object, select the “?” or “hand” icon using the right mouse button, place it over
the desired object, and click the left mouse button to activate. If you use the “hand" icon to pick up an object,
itis added to your inventory. (For more info on inventory, see “Your Inventory” below )



Keyboard Controls
Spacebar Same as right mouse button.
Enter  Same as Left mouse button.

Note:  The arrow keys or numeric keypad can be used to control directional movement of the pointer.

0 Sound On/0ff M Music On/0ff
P Pause Game A About Box
Fl Help F2 Options

F6  New Game F1  Load Game
F§  Save Game F9 Boss Key On/Off

FIT Walk Speed

Boss Key - The Boss Key can be activated by pressing the [F3] key. This option will instantly suspend your
game and change your screen to something that looks  bit more productive. Press the [FS] key again to return
{0 the game.

Walk Speed - The Walk Speed key can be activated by pressing the [F11] key. This option willallow you to con-
trol how fast Mike Dawson walks. Each time you press the [F11] key, you wil toggle between Slow, Medium,
and Fast mode.



GAME OPTIONS

You may access the game option menus by moving the pointer to the top of the screen. There are three menus:
file, Option!, and Help.

Choose the File menu to start a new game, to load an existing saved game, to save the current game in
progress, or {0 exit back to the operating system.

Choose the Option! menu to display a dialog box with several settings for how the game’s graphics and sound
are played. Options include sound effect and music volume, type of music playback you want, text display speed,
animation resolution, dialog options, and whether to skip or play transitional animations.

Choose the Help menu for intructions on how to play Dark Seed Il

The File Menu

To restart, save, load, or quit a game in progress, |
move the pointer to the top of the screen. A Win-
dows menu bar will appear. Place the pointer
over the File menu and click the left mouse button
to reveal the following options:

New Game

To start a new game from the beginning, click on
New Game or press F6.An alert box will appear asking if you really want to start a new game. Click the Yes huI
ton to Start a new game from the beginning. Click on the NO button if you change your mind and want to retur
{0 your game in progress.
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Load Game

Toload a previously saved game, select Load Game from the File menu or press F7. You'll see a window with
ten save-game slots. Click on the radio button to the left of the save-game slot you want to load, then click on
Load at the bottom of the window. If you change your mind, click on the Cancel button at the bottom of the window.

Save Game
To save a game in progress, select Save Game from the File o Eeorcomermsion s o
men or press FB.Youlsee a window withen save-game sots. — © e —

Click on the radio button to the left of one of the empty save-game @ [3he oot hat

J
]
]
J
O [-omsty ]
]
]
J

slots and then type in some descriptive text to remind you where | 55—

you were in the game. Finally, click on the Save button at the bot- ¢ Eles

tom of the window. Ifyou change your mind, lck on the Cancel o o -
button at the bottom of the window. If you want to re-use one of © Eewu= ]
the slots, simply select that one and type a new description there. N -
An alert box wil appear and ask you if you want to overwrite the previous game. Click Yes or No.

Exit

To quit the game at any time, select Exit from the File menu or press the ESC key on your keyboard. You will
be asked if you want to save your current game. Click on the YES or No button, and the game will end. If you
change your mind, click on the Cancel button,



The Option! Menu

Sound Effect Volume I Sound Effect Disabled

Toaccess the Option! menu, move the n_uimer 0He OO e | semevenme gl
screen and the click on the word 0ption! to open the Play " L _" o -
Setting dialog box. There are several options availablein | . "

this dialog box: SR Wes S Sey

Bhiie o iiraies . DA it
Sound Effect Volume: Use the mouse to move the lier to | e s " one o
the right to raise the volume; to the left to lower the volume of

the game’s sound effects and dialogue.
Sound Effects Disable: Click here to disable all sound effects and dialogue.

[ Skip Transitional Anims

Music Volume; Use the mouse to move the lider to the right to raise the music volume: to the left to lower the
music volume.

Music Disable: Click here to disable all music.
Music Type: Select either General MIDI or FM MIDI, depending on the type of sound card you have.

Text Display Speed: Click on the radio button that represents the text display Speed you prefer. You may
choose Fast, Medium, or Slow or Click. f you select Click, the text will not advance until you click the left
mouse button.

Animations: Click on the appropriate resolution for animations. If you aren’t sure what your display card can
handle, use the default setting.

Dialog Option: Choose the radio button that represents the way you want dialog to be presented in the game.

You can have both audio and text, audio only, or text only.
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Skip Transitional Animations: Click on the checkbox if you do not want to view the animations tat Some-
times appear when you travel to a new location. Even if you skip Transitional Animations, you will stll get all the
information necessary for solving the mystery.

The Help Menu

To access the Help menu, move the pointer to the top of the screen and then click on the word Help. An online
version of this manual will initiate, allowing you to more easily search for  topic. You can also access the help
menu by pressing the [F1] key.
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CONVERSATIONS

When Mike is talking with another character, a
Conversation Window will appear at the bot-
tom of the screen. The Conversation Window
contains the choices that Mike can make during a
conversation. To have Mike say something, move
the pointer over the text you want (the selected
text will turn white) and click the left mouse but-
ton. Mike will then speak the words aloud and the
other character will reply. When the other character has finished speaking, you may select another option unless
the conversation has ended. Clicking on the right mouse button when another character is talking will cause the
current speech to end, presenting your next option. Be careful not to click too quickly; you might miss a charac-
ter’s response. When the conversation is over, the Conversation Window will disappear.

Tothe lft of the Conversation Window s a skul icon. When more than three conversation choices are avail-
able, arrows will appear allowing you to scroll up or down through additional conversation choices. Be sure to
check for these arrows after another character has spoken. The Conversation Window only shows three lines
of text at a time. If the arrows appear, you have more conversation choices that you should consider. Use the
arrows to scroll all the way to the end before selecting an option. What you choose for Mike to say can radically
affect the game, so choose with care.
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YOUR INVENTORY

To view your current inventory, move the pointer to the bottom of the screen. The inventory window will appear
at the bottom of the game window. At the beginning of the game, there is nothing in your inventory, but when you
collect items, they will appear as icons in the inventory window. To examine an item in your inventory, place the
“1” pointer over the inventory item and click the left mouse button. To use Something in your inventory, use the
“hand” pointer. When you click on the item, the pointer will change to the shape of the item selected. Now you
may move the pointer and click where you want to use the inventory item. You may move the pointer anywhere
on the game screen or even over other inventory items. You'll notice that the pointer will appear as the “hand”
shape unless it is over something that can be manipulated or affected by the item you chose. To de-select an
inventory item after you've selected it, press the right mouse button; the item will remain in your inventory.

If you have more items in your inventory than will fit in the inventory window, arrow icons will appear at the left
and right edges of the inventory window. Click on these arrows to scroll through items that are currently not dis-
played.
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_HELPFUL HINTS

Ame start of Mike's adventre, you will only catch glimpses of the Dark World through Mike's dreams. As you
izlvn deeper into the mystery of Rita’s murder, Mike will have an opportunity to travel to the Dark World again.

' Ioclear his name, Mike will have to play the role of detective. As he gathers more and more information, be sure
' {0 visit Suspects and other sources of information again. A new piece of evidence may inspire Mike to notice
ttalls he had overlooked on first inspection.

Imu can't decide what lead to follow next, sit on the bench at Mike's front porch to see if his friend Jack is
mnsmu the neighborhood. Jack is a good source of information about the town's dirty little secrets.

Mtenever Mike gets a headache, go to Dr. Sims office for therapy sessions. Mike's hypnosis-induced dreams
r gan provide him insight into what happened during the night of the high school reunion.

 Hemember that the Dark World is a parallel to our Normal World. Actions in on universe can impact the other
- universe, particularly where the convergence is strongest.

" Thoroughly explore any mazes you encounter. One maze has a secrel that you must exploit to thwart the
-~ Ancients" plans.

Saue your game frequently, especially if you are about to try something dangerous or talk to an armed Dark
Warlder. Mike can die in the Dark World if he makes too many mistakes.

 Pay attention to the changes in the pointer shapes as you move them over objects and backgrounds. They pro-
yide important clues about your environment.
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BEGINNING WALKTHROUGH

This short walkthrough is intended to help you familiarize yourself with the way Dark Seed Il works. It isn't
meant to take you very far into the game, but simply to show you how to use the Conversation Window and how
1o explore the world.

Mike's Bedroom

At the beginning of the game, Sheriff Butler
shows up at Mike's door and questions him about
Rita’s murder. In this conversation, it dogsn't mat-
{er too much which options you choose, but some
options will reveal a lot more information. Some
of that information might turn out to be useful
[ater in the game, although obvious Statements,
like those about being late for the doctor, or hav-
ing  headache, will bring the conversation to  close.

When Mike's conversation with the Sheriff is over, the Sheriff will leave. Now you can explore Mike's bedroom.
This is a chance to familiarize yourself with the game controls.

1. Click the right mouse button a few times and notice how the pointer changes shape. The arrow-shaped
icon is the Go pointer. Use the Go pointer to move Mike from one place to another. The exclamation point
icon is the Look pointer. Use this pointer when you want to learn about something you See on the screen. The
hand icon is the Use pointer. Use this pointer when you want to pick up or manipulate something on the
screen or in Mike's inventory.
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Note that when you are using the Look pointer, it may appear as a question mark icon. Move it around on the
screen until it turns into an exclamation point, then click to get information about the object undemeath the
pointer. Also, although you will use the Go (arrow) pointer to make Mike move around, Mike will also move if you
tlick on an object with either the Use (hand) or the Look (exclamation point) pointer.

Keyboard Note: If you prefer to play from a keyboard, you can toggle between each of the three pointers by
pressing the Spacebar. You can then use the selected pointer by pressing the [Enter] key.

2. Change the pointer to either the Use or Look icons and move the mouse around. Notice that the pointers change
shape to indicate whether you can interact with a part of the room. For instance, moving either pointer from the
blank wall to the poster of the swashbuckling swordsman above the bed causes the icon to change a 7" to a
“I” When the look icon changes to an exclamation point, click the left mouse button to get information about the
poster. You'll hear a voice-over comment from Mike. Listen carefully to what he says; there may be a clue in it

3 Next, use the Look pointer to examine the trophy, by clicking the left mouse button when the icon is directly
over the trophy. Listen to what Mike says.

4. Click on the closet door with the Look pointer, and, again, listen to Mike.

5. Now you can explore other items in the room if you wish, but when you'e ready, switch to the Go pointer
(Arrow)by clicking the right mouse button. Next, move the GO pointer over the exit door on the far right of the
sereen. The GO pointer will change to the shape of four arrows pointing inward. Click the left mouse button.
This will cause Mike to leave the room and enter the Kitchen.

THE KITCHEN

Now you're in the Kitchen. Mike's mother, Mrs. Dawson, is busy at the stove, as usual. Perhaps she has some-
thing interesting to say. ...
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6. With the Use pointer, click on Mom. During this first conversation with Mom, you can discover a few more
background facts, but nothing critical. If Mike mentions that hes getting a headache, Mrs. Dawson will remind
him of his medicine. “That's what it’s for,” she says.

1. Once you've completed the first conversation with Mom, and she returns to her cooking, click o her againto
get a clue about watching television.

8. With the Look pointer, examine the room. You'll notice some obiects on the refrigerator
9. Switch tothe USe pointer and click on the happy-face magnet. Mike will take the magnet and putitin his pocket.

10. Now move the pointer to the bottom of the screen. The Inventory Window will appear, and you'll see that the
magnet has been added to Mike's inventory.

If you click on the magnet (or any object in
inventory) with the Look pointer, Mike will make
some comment or observation about the object. If
you click on the magnet (or any object in inven-
tory) with the USe pointer, the pointer will
change to a shape that resembles the object
you've selected. Try it.

11. With the Use pointer active, click on the
magnet and then move the pointer around in the
00
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Notice that the pointer looks like & hand until you place it over the refrigerator. Then it changes to look like the
magnet. This tells you that the magnet can be used with the refrigerator. If you click on the refrigerator now, Mike
will return the magnet. To put the magnet back in Mike's inventory, drag the pointer to the bottom of the screen
again, opening the Inventory Window, and click on the magnet again.

12. Assuming you still have the magnet, there’s not much more to do here. Perhaps you will find something to do
in the Living Room. With the Move pointer, click on the door to the right.

Now you're on your own. Good luck. O, and if you really need more help...

IFYOU NEED ADDITIONAL GAME PLAY HINTS, YOU CAN REACH OUR
HINT LINE AT 1-900-407-HINT (446)

You must have a touch-tone phone to use this Service. The hint line is available 24 hours  day. The charge is $.95
per minute. You must be 16 or have parental permission to use this service. Cyberdreams, Inc. Calabasas, CA.

O YOU CAN PURCHASE THE OFFICIAL STRATEGY GUIDE BY CALLING THE CYBERDREAMS
ORDER LINE AT 816-225-1049

The Dark Seed Il Official Strategy Guide is only $19.95 + $6.50 for shipping in the USA, California residents add
8.25% sales tax. Canadian orders add $9.50 (US currency only) for shipping. Visa or Mastercard accepted.
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TROUBLESHOOTING

Video Problems
Verity that your screen resolution i 640x480 8 bits (256 colors), for best results and that you are using the most
current driver for your video card. Contact your video card manufacturer for more information.

Audio Problems

Ensure your sound card s properly installed and verfy that all required sound card drivers are installed in Win-
dows. For more information, consult your Windows or sound card manual, or contact your sound card
manufacturer.

Mouse Problems
Make sure you are using a 100% Microsoft compatible mouse.

No Multi-tasking
Because of the large amount of system resources that Dark Seed Il requires, you should not attempt to use any
multi-tasking functions or run other programs while playing Dark Seed II.

Screen Savers and Audio Clips
While using Dark Seed |1 you should disable any screen savers or audio clip software that are enabled.
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Window Swap File (for Windows 3.1 or 3.11)

Dark Seed Il uses the windows swap fil to speed up game play. If you have a system with 8Mb of RAM or less,
You will need to verify that your swap file size is at least 10.000 K. 1f your system containg 16Mb of RAM, you
can set the swap file to as lttle as 4,096 KB. We also recommend that you change to a permanent swap file rather
than a temporary Setting.

To check how much memory has been allocated in your swap file settings and make changes, do the following:

1) Activate the Windows Control Panel by double-clicking on the Windows Control Panel Icon, then dot-
ble-click on the 386 Enhanced Icon.

2) Within the 386 Enhanced window, clck on the Virtual Memory... button

3) Verify that the Swap file size is at east 10.000 KE if your system has 8Mb of RAM or less. If your system
has 16Mb of RAM , you can set your swap file to as litdle as 4,096 8.

4)To make changes to your Swap File Settings, lick on the Change>> Button,

5) Inthe New Size: box located in the lower section of the Virtual Memory window, type in the new size.Also
veriy that your swap file type is set to permanent in the Type: section.

6) Click OK, then elick Yes to save your changes. next, clic on the Restart Windows button to make Windows
restart with your new settings.
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TECHNICAL ASSISTANCE

If you are experiencing technical difficulties with Dark Seed Il and you are a registered user, you may call
our technical support department for assistance at (816) 222-9348. Cyberdreams technical support is avail-
able during normal business hours (Mon-Fri, 9am to 5pm PST). To better serve you, please have information
regarding the manufacturer, model, operating System, available memory and system configuration of your com-
futer when you contact us.

If you have a modem, you can also contact us through our Bulletin Board Service by diafing (816) 223-8739.

On-line Support Via CompuServe

For on-Jine support of Dark Seed |1 via CompuServe, call (800) 524-3388 (in North America) and ask for rep-
resentative #503 to get your FREE introductory membership and $15.00 usage credit. If you are already a
member of CompuServe, type the command GO GAMAPUB at any ! prompt to get the Cyberdreams support area
(Section/Library 5), or contact our technical support department at |D# 72662,120.
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ABOUT H. R. GIGER

H.A. Giger was born in Chur, Switzerland in 1940. As a child, he developed a powerful fascination with all things
-~ sureal and macabre. His need to express himself and share the unigue aspects of his vivid imagination drew
i to the visual arts. Giger's own dreams and the brilliant imagery of such fantastique geniuses as Gustav
-~ Meyrink, Jean Cocteau, Alfred Kubin and H.P Lovecraft, combined to form a rich soil from which the amazing
- imagery of Giger's art has come to Sprout. It has grown into the vast canon of exotic women, wondrously dis-
turbing landscapes and frightening creatures that has captured the fascination of millions of fans worldwide.

Meticulously detailed, Giger's paintings are done on large canvases and worked and reworked by this maestro
of the airbrush. It was Giger's popular art book, Necronomicon, that caught the eye of director Ridley Scott as he
was searching for the right look for a creature in his upcoming film. That creature, of course, turned out to be the
Alien, and Giger's masterful designs for the film of that same name garnered him a much deserved Academy
Award.

Giger's fascinating biomechanical style, that brilliant synthesis of flesh and machine, has been realized not only
through his paintings, but also through sculpture pieces, elegant furniture, and architectural and interior design
projects. His paintings have been displayed in galleries and museums throughout the world. H.A. Giger has
gamed his place in the international art scene.
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“Biger is the master of fantastic art”
OMNI MAGAZINE

“Giger's Oscar-winning work on ALIEN changed the ook of science fiction”
CINEFANTASTIQUE

“Giger knows what we fear”
HARLAN ELLISON

“his silence is as profound as his genius”
CLIVE BARKER

“One of Europe’s leading fabulist artists”
PENTHOUSE

“Brilliantly perverse”
NEWSWEEK

“The evolutionary genius. . . Giger”
TIMOTHY LEARY

“H.R. Giger creates eerie erotic fantasies with a nightmare imagination and an airbrush”

PEOPLE MAGAZINE
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THE MAKING OF DARK SEED II

“It's beautiful!“ was H. R. Giger's enthusiastic reaction upon seeing the original Dark Seed for the first time. As
a world-renowned fine artist, Giger was skeptical when Cyberdreams initially approached him about creating a
computer game based upon his macabre “biomechanical” landscapes. He agreed to grant Cyberdreams access
to his body of work only after lengthy negotiations. But when Giger saw the great care that Cyberdreams had
taken to preserve the elements of his art, he was pleased with how effectively his images translated to an inter-
active environment. Game players were equally pleased with Dark Seed. The game became a sleeper hit
winning the Software Publishers Association’s 1393 Excellence in Software Award for Best Fantasy Role-Play-
ing/Adventure Game.

Dark Seed players wanted to see more of hero Mike Dawson's nightmarish journey into Giger's Dark World, and
$0 Cyberdreams brought in game producer David Mullich to create the sequel. Not only had Mullich developed
other adventure games with dark psychological themes such as The Prisoner and | Have No Mouth, And | Must
Scream, he also admitted to being a Giger fan since high school, when he bought an Emerson, Lake and Palmer
album with a cover designed by the Swiss surrealist. With the goal of surpassing the high standards set by the
original Dark Seed, he assembled a development team of the most talented and demented minds working in
interactive entertainment.

Since Giger's disturbing images have had such a profound impact on science fiction literature and cinema —
he designed creatures appearing in the films Alien, Poltergeist II and Species — it seemed fitting that the
sequel should have literary quality. Designer Raymond Benson, whose software credits include Stephen King's
The Mist, Uttima V11 -The Black Gate, Return of the Phantom and Are You Afraid Of The Dark?, was commissioned
{0 write a story that continued Mike Dawson's horrifying adventures. Instructed that the sequel also must take
Mike Dawson from our Normal World into Giger's Dark World, Benson crafted a psychological murder mystery

that begins in a quirky, “David Lynchian” small town and draws us into  terrifying alternate universe that is a
24



metaphor for madness. Those who reach the game’s chilling conclusion will appreciate how well Benson’s tale
allegorizes what Giger says about his art: “1 expel these creatures, and their pain, by painting them onto a sur-
face, trapping them forever. In a somewhat symbolic manner, | also free myself.”

Giger later requested that the sequel include images that had recently been haunting him, including a sled car-
rying a vat down the banister of an endless staircase (inspired by Giger's “Shaft” pieces). Since Benson had
moved on to other projects, Cyberdreams consulted science fiction author John Shirley (The Eclipse Trilogy, and
the screenplay for “The Crow”) on how to fit Giger's visuals into the sequel, and he also contributed many addi-
tional ideas for fleshing out the Dark World. To put the finishing touches on the game dialogue, Cyberdreams
brought in Keith Herber, a horror author who edited the Call of Cthulhu role-playing game and is an expert on H.
P Lovecraft.

Once the game design was completed, Cyberdreams hired Destiny Software Productions of Vancouver, Canada to
implement it. For the original Dark Seed, Giger had insisted that Cyberdreams use a high resolution VGA graph-
ics mode (640 by 350 pixels, 16 colors) to avoid the “square and jagged” ook found in most computer games of
the time. So that the sequel would also be visually cutting edge, Destiny's programming team enhanced their
graphics routines to support an even more advanced graphics mode, SVGA (640 x 480 pixels, 256 colors), while
running under a Windows or Windows 35 environment.

Tocreate the character animations of Mike Dawson and the other Normal World denizens, Destiny photographed
the movements of live models with a high speed camera, scanned the photographs into digital form, and played
images back as animations. In addition to professional performers, some of Destiny’s staff members volunteered
to be character models. By a happy coincidence, artist Chris Gilbert was a dead-ringer for the Mike Dawson
character from the original Dark Seed.

The art team at Destiny also proved to be skilled at combining a variety of imagery from Giger’s fantastic art-
o5



work and using both 2-D and 3-0 techniques to create new Dark World backgrounds. Several months into the
project’s development, Mullich, Cyberdreams” art director Peter Delgado, and Destiny artist Gregg Haggman vis-
ited Giger's home in Zurich to show off their progress. Giger was very impressed with the graphic improvements
over the original Dark Seed, and offered many helpful suggestions about scaling, placement and composition.
One of his most significant contributions was the placement of metal catwalks throughout the Dark World, so
that Mike Dawson would always feel in peril, being continuously suspended over a bottomless pit.

So that the Normal World would have an equally distinct look, Cyberdreams enlisted the talents of artist Jeff
Hilbers to create the Normal World backgrounds. Hilbers, who has previously served as art director on producer
Mullich’s projects when both were at The Walt Disney Company, brought his unique sense of the macabre to Mike
Dawson's home town. The quaint images of what superficially appears to be a pleasant community proves on
tloser inspection to be infected with perversity, symbolizing the Dark World's growing influence on Crowley,
Texas.

Audio was the final element needed to immerse you into Giger's ghastly universe. Cyberdreams commissioned
television and film composer Mark Morgan (Stephen King's The Stand television mini-series) to write more than
20 pieces of original MIDI music for the adventure, which music producer David B. Schultz of DBS Music then
specially arranged for optimum performance on the Sound Blaster AWE32 card. Destiny Software Productions
then added haunting sound effects and ambiance through the game.

With more than forty speaking parts in the adventure, Cyberdreams contracted Lisa Wasserman of Virtual Cast-
ing to cast and direct some of the finest voice-over actors performing in interactive entertainment. The dialogue
sessions were recorded at Lucas Art's old Skywalker Sound facilities in Los Angeles by Cheshire Multimedia
Sound. Sound engineers Todd Bozung and Greg Chapman digitally enhanced many of the voices to help drama-
tize Giger's world of biomechanoids, goddesses and diabolical creatures.
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Upholding Cyberdreams" reputation for innovative packaging, Director of Sales and Marketing Andrew Balzer
commissioned Bright & Associates to create a box design that was as provocative as the adventure contained
within. The box showcases a portion of Giger's 1978 piece “Illuminatus |,” in which 8 woman's cheek is pierced
by her safety-pin sunglasses. The adventure will be made available through the efforts of Cyberdreams Sales &
Marketing team of Andrew Balzer and Daniel Pelli together with MGM Interactive (responsible for North Ameri-
¢an distribution) and Cyberdreams’” foreign distributors.

The production, development and marketing team for Dark Seed |1 have unleashed a new hurr'ur into Mike Daw-
son’s unending nightmare. As you take this dark journey into the depths of madness, we hope that, as Giger tries
10 do with his own artwork, you free yourself of some of your own demons.
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ABOUT CYBERDREAMS

Cyberdreams was formed to create high quality interactive entertainment software for home computers and ded-
icated game systems. Each product is designed, scripted and Story boarded by game play experts and world
famous artists, designers, writers and filmmakers such as H.A. Giger (Alien, Species), Syd Mead (Blade Runner,
Tron, 2010), Harlan Ellison (the most honored author in the world of imaginative literature) and Wes Craven (cre-
ator of A Nightmare on Elm Street). Cyberdreams” audience is adult science-fiction enthusiasts who appreciate
sophisticated storylines, state-of-the-art animation and cutting-edge interactive technology.
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LIMITED WARRANTY

LIMITED WARRANTY. CYBERDREAMS, INC. warrants to the original consumer purchaser that the diskettes or CO-ROM furnished in this product (here-
inafter, Software) will be free from defects in materials and workmanship under normal use for a period of ninety (30) days from the date of purchase
(as evidenced by the receipt of purchase).

CONSUMER REMEDIES. CYBERDREAMS, INC's. entire lability and the original consumer purchaser's exclusive remedy shiall be, at CYBERDREAMS, INC'.
option,repair or replacement of the Software that does not meet CYBERDREAMS, INC.s Limited Warranty and which is returned to CYBERDREANS, INC.
with a copy of the receipt of purchase. This Limited Warranty is void if failure of the Software has resulted from accident, abuse, or misapplication.
Any replacement Software will be warranted for the remainder of the original warranty period or 30 days, whichever is longer.

PRODUCT IS SOLD AS IS THE SOFTWARE, DISKETTES OR CD-ROM, DOCUMENTATION AND OTHER ITEMS ARE PROVIDED AS IS THERE IS NO WARRANTY
OF MERCHANTABILITY, NO WARRANTY OF FITNESS FOR A PARTICULAR USE, AND NO OTHER WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED
REGARDING THE SOFTWARE, DISKETTES OR CO-ROM OR DOCUMENTATION, EXCEPT AS EXPRESSLY PROVIDED IN THE PRECEDING PARAGRAPHS. THE
ENTIRE RISK TO THE USE, RESULTS AND PERFORMANCE OF THE SOFTWARE, DISKETTES OR CO-ROM, AND DOCUMENTATION IS ASSUMED BY THE CON-
SUMER.

CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL CYBERDREAMS, INC, OR ITS SUPPLIERS BE LIABLE TO THE CONSUMER OR ANY THIRD PARTY FOR ANY
CONSEQUENTIAL, SPECIAL OR INDIRECT DAMAGES RESULTING FROM POSSESSION, USE, O MALFUNCTION OF THIS PRODUCT, INCLUDING WITHOUT LIM-
(TATION, DAMAGE TO PROPERTY, AND 0 THE EXTENT PERMITTED BY LAW, DAMAGES FOR PERSONAL INJURY, EVEN IF CYBERDREAMS, INC. HAS BEEN
ADVISED OF THE POSSIBILITY OF ANY SUCH DAMAGES OR LOSS. SOME STATES DO NOT ALLOW LIMITATIONS ON THE DURATION OF IMPLIED WAR-
RANTIES AND/OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, AND THUS THE PRECEDING LIMITATION AND/OR
EXCLUSIONS AND LIMITATIONS MAY NOT APPLY.

LEGAL RIGHTS. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER RIGHTS DEPENDING ON'THE LAWS IN YOUR STATE.YOU
AGREE THE LIABILITY OF CYBERDREAMS, INC. ARISING OUT OF ANY KIND OF LEGAL CLAIM (WHETHER IN CONTRACT, TORT, DR OTHERWISE) WILL NOT
EXCEED THE AMOUNT YOU ORIGINALLY PAID FOR THE USE OF THIS PRODUCT.

COPYRIGHT. The enclosed software product and this manual are copyrighted and all rights are reserved by CYBERDREAMS, INC. No part of this man-
ual or any of the accompanying materials may be copied, reproduced, translated in any form or medium without the prior written consent of
(YBERDREAMS, INC.

NOTICE. CYBERDREAMS, INC. reserves the right to make improvements in the product described in this manual at any time and without notice.
CYBERDREAMS, INC. 23586 Calabasas Road Suite 102 Calabasas, CA 91302
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Dark Seed 1 is a trademark of Cyberdreams, Inc. Cyberdreams is a registered trademark of Cyberdreams, Inc. Mustrations Muminatus | © 1976 H. B. Giger. Al Rights Reserved.
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